
Assignment 7 Dimensioning CAD Fundamentals I 
Due March 8  Architecture 411 

Objective 

To become familiar with methods of architectural dimensioning. 

To learn how to set up dimensioning styles in AutoCAD. 

To learn to use semi-automatic dimensioning commands to indicate sizes and locations in construction 
drawings. 

Exercise 

 1. Reopen your layered floor plan drawing (from Assignment 5). 

 2. Save the drawing under a new name.   

 3. Create a new layer for dimensioning information.  Use whatever color you want, but set the 
lineweight for the layer to “0.00mm”.  Dimensions are thin lines.  Make sure that your current 
entity lineweight (set through the Properties toolbar) is “ByLayer”. 

 4. Reset the precision in your drawing.  In this assignment, you may have to specify some very 
small distances.  In order to be able to specify them, you will have to tell AutoCAD to allow you 
to be extra-precise. 

Go to the Units dialog box (“Format->Units…”) and set the “Precision:” to 1/32” or 1/64”: 

 

Click OK when done. 
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 5. Set the dimensioning variables.  AutoCAD uses a large number of system 
variables that control how dimension lines are drawn.  These govern such things as the sizes of 
arrowheads, text, and gaps in dimension lines; the units of the dimensions; etc.  Technically, you 
can modify these variables from the command line: 

Command: dimcen 
Enter new value for DIMCEN <0.0900>: 
 
Command: dimdec 
Enter new value for DIMDEC <4>: 
 

However, this method is seldom used.  It is generally much easier to set the dimensioning 
variables through the Dimension Style Manager and subsequent dialog boxes.  Choose 
“Dimension->Style…” or “Format->Dimension Style…” from the pull-down menus.  You should 
see a dialog box like the following: 

 

Click the “New..” button to start defining a new dimensioning style.  (You can use the “Modify…” 
button later if you need to change some of your settings.)  A small dialog box like this will 
appear: 
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Provide a name for your new dimensioning style.  Also, select “STANDARD” as the existing style 
to use as a starting point for defining your own dimensioning style.  Select “All dimensions” in 
the “Use for:” listbox.  Click “Continue” once you have done these things, and you will proceed to 
a larger dialog box: 

 

In this dialog box (which has multiple tabs), you will define how you want your dimensions to 
appear.  You will define whether your dimension lines should have tick marks, arrowheads, or 
dots, what they should look like, and how big they should be.  You will say what text style to use 
for the dimension numbers, how big the text should be, whether the numbers should be above 
the dimension lines or in a gap in the middle of the line, how much space there should be 
between the text and the dimension line, etc.  There are dozens of these settings. 

You should define your own unique style for dimensions.  Do not use the defaults.  Do not try to 
exactly copy the styles you see in the illustrations of this tutorial (although you should use any 
settings that this tutorial text explicitly tells you to use).  Do not copy the settings that you see 
other people using.  Pick your own settings to define a style that is clear and readible. 

Note that dimensions are purely functional.  They appear on construction drawings that are 
given to contractors, not presentation drawings for clients.  (Even when well-composed, 
dimensioned working drawings tend to be a bit cluttered, and are usually bewildering to those 
who are not used to working with them.)  They do not need to be artistic, but they do need to be 
clear and readible; otherwise, the effect can be catastrophic. 

“Under the “Lines and Arrows” tab, you set variables that affect the appearance of extension 
lines (the lines that extend out from the object being dimensioned) and dimension lines (the lines 
that are generally parallel to the object being dimensioned, and which usually have the actual 
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dimension text written in them or above them).  This tutorial will not describe every setting; there 
are just too many of them.  Instead, you should try changing various values, and watch the 
picture in the upper right corner of the dialog box to see how the appearance of the example 
dimensions changes. 

Use “ByBlock” for the colors and lineweights specified in the dialog box, unless otherwise noted.  
For Arrowheads and various “size”, “extend”, “spacing”, and “offset” values, choose settings that 
you think are legible and look good. 

Once you have set the variables under the “Lines and Arrows” tab, you should move on to the 
“Text” tab: 

 

Be sure to choose a readable Text style to use, instead of the crude standard font.  If necessary, 
click the “…” button to define a new text style.  Leave the “Text color” as “ByBlock” and the “Fill 
color” set to “None”.  Choose other values that are legible and good-looking. 

Proceed to the “Fit” tab. 
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When you dimension drawings, you will often find that the distance being dimensioned is so 
small that the dimension text can not fit between the extension lines.  The left half of the dialog 
box says what to do in these situations. 

On the right half of the dialog box, pay particular attention to the “Use overall scale of” value.  
This is a multiplier for all other dimension variables.  Setting this variable lets you specify final 
plotted sizes for the dimension variables instead of specifying drawing unit (model space) sizes. 

You will eventually be plotting this drawing from a layout tab.  Your plan will be visible in a 
viewport in the layout.  That viewport will be ZOOMed to an architectural scale.  Figure out what 
scale this will be.  In the “Use overall scale of” box, put the ratio of model space to paper space 
units for this scale.  For instance, if you were going to ZOOM to a scale of 1/8”=1’ (1/96xp), the 
ratio of drawing units to plotting units would be (12”/0.125”) = 96.  Note that this is an especially 
important setting.  It affects the results of almost every other setting.  It affects every dimension 
you draw in multiple ways. 

Do not worry if you don’t end up plotting at the scale you first guessed.  If you change your mind 
about the plot scale, all you need to do is update the “Use overall scale of:” variable. 

Note that while you can change the “Use overall scale of:” value, you can still only have 
one value for it at a time.  So if the same dimensions appear in two different viewports 
that are zoomed to two different scales, the arrowheads, text size, offsets, etc. will 
appear larger in one viewport than in the other one.  Because of this, many firms will 
use more than one dimension style in the same drawing – one style for one scale, and 
another style for another scale.  Since you can freeze/thaw different layers in different 
viewports, you can draw one set of dimensions on one layer using one dimension style 
for the scale of one viewport, and draw another set of dimensions on a different layer 
using another dimension style for the scale of the other viewport. 
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The “Scale dimensions to layout (paperspace)” setting is probably intended to eliminate 
the need for you to compute the ratio of model space units to paper space units, but it 
still computes only one value.  You still need to use two dimension styles if the same 
drawing will appear at different scales in different viewports. 

Scaling dimensions to paperspace is a bit tricky, because it only works properly if you 
are working in model space editing mode in a layout.  If you are working using the 
model tab, AutoCAD can not properly compute the ratio of model space to paper space 
units.  (Which layout’s paper space would it use to compute the ratio?)  However, it is 
often difficult to work in a viewport, because the viewport usually reduces the amount of 
space on the screen that you can work in. 

The last tab you need to pay attention to is the “Primary Units” tab. 

 

It is important to set “Unit format:” (at the top of the dialog box) to “Architectural”.  Otherwise, 
dimensions will not show feet and inches.  The UNITS command sets how AutoCAD lets you 
enter coordinates and distances, and how it displays them in the coordinate odometers and 
other places.  The “Unit format:” that is part of a dimension style affects how distances are 
written in dimension text in the drawing. 

Leave the “Scale factor” under “Measurement Scale” set to 1.00000. 

The “Zero Suppression” checkboxes can be used to make dimension text more concise when it 
has zeroes in it.  You can use some of these checkboxes to make 0’-4” be displayed in a 
dimension as 4”, or make 12’-0” be displayed in a dimension as 12’.  The decision of whether or 
not to check the “Zero Suppression” checkboxes is left to your discretion. 
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Click the “OK button when you are finished setting values under the “Primary Units” tab. 

 6. Set your new dimension style to be the current dimension style.  This can be done using the 
Styles toolbar. 

 7. Save your drawing.  After this step you will practice dimensioning commands, so it is a good 
idea to save the drawing first, in case you make mistakes, and want to revert to this version of 
the file. 

 8. Practice using linear dimensions.   

Since you will be doing a lot of dimensioning for the remainder of this assignment, you might 
want to make the dimensioning toolbar visible, by choosing “View->Toolbars…” from the pull-
down menus.  Check “Dimension” in the dialog box: 

 

Click “Close”; this will display the “Dimension” toolbar, which you can dock to the AutoCAD 
window frame for easy access: 

 

Create some linear dimensions.  The command for this can be invoked using the leftmost icon 
on the Dimension toolbar, or by selecting “Dimension->Linear” from the pull-down menus.  It can 
also be invoked from the keyboard: 
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Command: dimlinear 
Specify first extension line origin or <select object>: <click> 
Specify second extension line origin: <click> 
Specify dimension line location or 
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: <click> 
Dimension text = 30’-8” 
Command: 
 

Regardless of how you invoke the command to place a linear dimension, you will need to 
specify three points.  The first two points specify the starting and ending points for the 
dimension.  These are the points from which extension lines will be projected.  Use snapping, 
object snapping, or other tools to make sure that you specify these points accurately.  If you do 
not specify these points accurately, AutoCAD will miscalculate and therefore mislabel distances.  
In actual architectural practice, this could mislead a contractor or construction worker, causing 
expensive (or possibly even dangerous) mistakes during building construction. 

The third point you enter when placing a linear dimension specifies the location of the dimension 
line.  You should probably take advantage of snap settings when placing this point.  Using snaps 
will help you keep dimensions neatly lined up with one another, which is one of the things that 
you will be graded on. 

Notice that when you place a dimension, there are a lot of things that you don’t have to 
do.  Most notably, you don’t have to tell AutoCAD what number to write in the 
dimension line.  AutoCAD computes the distance between the points you specify, and 
writes this distance for the dimension.  This is called “semi-automatic dimensioning”, 
because while you need to specify the start and end of the dimension, AutoCAD 
identifies the distance automatically. 

After you have placed a few dimensions, select one of the dimensions that you placed, so that it 
is highlighted with blue grips.  Grab one of the grips at the base of an extension line, and 
reposition it.  Note that the dimension line adjusts to the repositioned extension line, and the 
dimension text also changes to reflect the new distance. 

 9. Practice using aligned, baseline, continued, and angular dimensions.  Also practice center 
marks and radius dimensions if your floor plan has curves. 

 10. Practice using either DIMTEDIT or grip editing to reposition dimension text.  You will find 
yourself needing to do this a lot in the following step. 

 11. Completely dimension your floor plan drawing.  Make sure that you indicate the positions of 
each wall, window, and door.  Use the class lectures and the “Architectural Dimensioning” 
handout as guidelines for how to dimension.  Do not dimension furniture (except for built-in 
furniture).  In fact, you should freeze the furniture layer(s), although you can leave the plumbing 
fixtures thawed.  For clarity (and to give yourself room for dimensions), you should also freeze 
the patio layer and any layers you might have that contain site elements like trees.  You should 
keep room names, if you can fit them in, but freeze or erase the rough room sizes. 

You will be graded on neatness.  Your dimensions should overlap with other drawing elements 
as little as possible.  Dimension text should never overlap anything else; it should always be 
readable (at least 1/16” tall).  If you leave your walls pochéd, make sure that any dimension lines 
can be easily discerned against them. 

Do not place dimension lines far from the house plan; in the finished plot, they should be only 
about half an inch to an inch or so away from the exterior walls (in terms of inches on the paper, 
not model space units).  In general, extension lines should not quite touch the object they 
dimension, although they should be in line to do so, and the gap should be very small (like 1/16” 
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or 1/32”—there is a setting for it).  “Continue” a dimension whenever possible, and use 
“Baseline” for stacking parallel dimensions.  

You will probably find it difficult to get your dimensions to fit in the drawing.  Use DIMTEDIT or 
grip editing to position your dimension text someplace where it will be readable.  Dimensions will 
be easier to fit in if you plot on 11x17” paper. 

Once you start dimensioning, you are likely to discover that you need to modify some of your 
dimension style settings (probably to make them smaller).  You can simply return to the 
Dimension Style Manager to do this, and modify the style you have been using.  After you do 
this, AutoCAD 2005 generally updates all previously drawn dimensions that use that style.  
However, in some situations or with some versions of AutoCAD, you might need to force old 
dimensions to be updated. 

To force AutoCAD to update old dimensions, choose “Dimension->Update” from the menus, or 
click the “Dimension Update” icon from the Dimension toolbar.  When prompted to select 
objects, type “all”.  Dimensions should then be updated; anything that isn’t a dimension will be 
ignored. 

 12. Plot your dimensioned floor plan drawing.  You should plot a layout, so if you don’t have an 
existing layout that is appropriate, you will need to set one up, complete with a title block, border, 
and title block text.  Make sure that the viewport is on layer DEFPOINTS, and in the viewport, 
zoom to the equivalent of an architectural scale.  Also include some text in the layout that 
indicates that scale.  You will be counted off if your plan is not at an architectural scale (or not at 
the scale you indicate) in your plot. 

As with previous plots you have made, you should make sure you have appropriate lineweights.  
Make sure that you plot using the “monochrome.ctb” color table.  These things should become 
standard practice for you, and will not be mentioned in future assignments.  Examine the plot 
preview carefully, and if you are satisfied, plot the layout. 

Examine your plot carefully for errors.  You will be counted off if your dimensions are not drawn 
with very thin lines, if your wall lines are just as thin as your dimension lines, if your dimension 
text is not readable, or if corresponding parts of different dimension lines are different sizes.  
You will be counted off if you have walls, windows, or doors that do not have dimensions to 
indicate where they are located.  You will also be counted off if your dimension text overlaps with 
other objects, or if you have dimension lines crossing extension lines unnecessarily.  All the 
dimensions in a plot should be consistent in style and readable.  Any overall dimension should 
match the sum of its constituent short dimensions.  If necessary, correct errors and re-plot. 

 13. Save your work, close the drawing file, and open your fountain drawing from Assignment 2.   

 14. If the current UCS is not “World”, change it to “World”. 

 15. Create a new dimensioning style, with settings that are different from the style that you used for 
the floor plan.  The differences between the dimension styles should be easily apparent.  The 
dimension style for the fountain should also be different from the style shown below, and 
different from what you see other people using. 

  Set your new style to be the current dimensioning style. 

 16. Practice using radius and angular dimensions.   

 17. Dimension your fountain drawing as shown below.  Create a new layer for your dimensions, and 
give it a lineweight of 0.00mm.  Make sure that “ByLayer” is selected for the entity color and 

Assignment 7 Dimensioning CAD Fundamentals I 



10 

lineweight in the “properties” toolbar.  Dimension the same angles, radii, distances, etc. as 
shown below, and include similar leaders and notes, but use the dimensioning style you defined.  
You can add additional notes, if you like. 

 

Do not worry if you drew your fountain incorrectly; you can still use your fountain file without 
penalty.  Dimension your angles and radii according the actual angles and radii in your drawing.  
(So, for example, if your street is at a 90 degree angle instead of an 80 degree angle, your 
angular dimension should read “90°” instead of “80°”.) 

 18. Plot your dimensioned fountain drawing.  Plot from a layout, with some sort of title block, border, 
and title block text.  Make sure that your viewport is on layer DEFPOINTS and is zoomed to an 
architectural scale (most likely 1/8” or 3/16” = 1’-0”) before you plot, and include some paper 
space text that indicates what the scale is. 

Of course, you should make sure you have appropriate lineweights.  Make sure that you plot 
using the “monochrome.ctb” color table.  Examine the plot preview carefully, and if you are 
satisfied, plot the layout and check it carefully. 

 19. Embellishment/additional work.  Some floor plans are more difficult to dimension than other floor 
plans are.  Plans with numerous interior walls, lots of closets, many doors/windows, and/or 
angled or arcing walls are more difficult to dimension (and dimension clearly) than a simple plan 
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with just a few walls and openings.  Therefore, complex plans that are dimensioned well will be 
considered to have significant embellishment/extra work. 

  Additional embellishment points can be earned by dimensioning additional floor plans.  
Alternately, you could add additional details to the fountain and dimension them.  You could 
dimension the driveways, sidewalks, etc. in your site plan, or you could create a drawing 
showing stairs, a fireplace, or some other detail of interest (in section or elevation view), and 
dimension the drawing.  If you wish, you can also dimension a non-architectural drawing, like a 
drawing of a machine part, road, or structure. 

  As with the first two plots for this assignment, any additional plots you turn in should have 
appropriately sized arrowheads, extensions, offsets, etc.  They should be plotted from a layout, 
and should have borders and titles on the sheet.  The viewport should be on layer DEFPOINTS, 
and should be scaled so as to show the drawing at some appropriate architectural or 
engineering scale.  Naturally, the drawing should make used of appropriate lineweights, and 
should be plotted using the “monochrome.ctb” color table.  This is the last time you will be 
reminded about scales, lineweights, viewports on layer DEFPOINTS, or the color table, but you 
will continue to be responsible for using them correctly. 

 

What’s due: 

A plot of your dimensioned floor plan (step 12).  Make sure that you plot 
a layout with an appropriately ZOOMed viewport, and that you 
check for potential problems, as described in step 12. 

A plot of your dimensioned fountain drawing without the other corners 
(step 17).  Plot a layout with your viewport zoomed to an 
architectural scale. 

Plots of any additional drawings that you decide to do as 
embellishments/additional work (step 18).  Make sure that you 
plot a layout with an appropriately ZOOMed viewport, and that 
you check for potential problems, as described in step 12. 
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